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Практическая подготовка № 1 

Работа инструментом перо в Photoshop Теоретическое обоснование  

Аппаратура и материалы. Для выполнения работы необходим 

персональный компьютер со следующими характеристиками: процессор Intel с 

тактовой частотой 2000 МГц и выше; оперативная память – не менее 128 Мбайт; 

свободное дисковое пространство – не менее 800 Мбайт; устройство для чтения 

компакт-дисков; монитор типа Super VGA (число цветов  – 256)  с диагональю 

не менее 17. Программное обеспечение – операционная система WINDOWS 10 

/ NT / ME / 2000 / XP/2003,  браузер.  

  Указания по технике безопасности. Техника безопасности при 

выполнении  практической  работы  совпадает  с  общепринятой 

 для пользователей персональных компьютеров. В частности, самостоятельно не 

производить ремонт персонального компьютера, установку и удаление 

программного обеспечения; в случае неисправности персонального компьютера 

сообщить об этом обслуживающему персоналу лаборатории (оператору, 

администратору); соблюдать правила техники безопасности при работе с 

электрооборудованием; не касаться электрических розеток металлическими 

предметами; рабочее место пользователя персонального компьютера должно 

содержаться в чистоте; не разрешается возле персонального компьютера 

принимать пищу, напитки. Цель и содержание: ознакомить обучающихся с 

работой инструментом «Перо» в Adobe Photoshop.  

Методика и порядок работы Для выполнения задания воспользуемся 

предоставленным уроком инструмент «Перо» в Adobe Photoshop.  

Задание  Методика и порядок работы  

Для выполнения задания воспользуемся предоставленным уроком 

«Вафельная текстура»  

В Photoshop предоставляется несколько инструментов «Перо», которые 

подойдут для ваших вариантов использования и стиля:  

• Инструмент «Перо кривизны» позволяет интуитивно рисовать 

кривые и прямые отрезки.  

• Стандартный инструмент «Перо» позволяет рисовать прямые 

отрезки и кривые с большой точностью.  

• Инструмент «Свободное перо» позволяет рисовать контуры так, как 

вы выполняете рисунок карандашом по бумаге.   

• Параметры инструмента «Магнитное перо» позволяют нарисовать 

контур, который примыкает к краям указанной области изображения.   

Используйте сочетание клавиш Shift+P для циклического просмотра 

инструментов в группе «Перо».  
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Циклический просмотр инструментов «Перо» с помощью сочетания клавиш 

Shift+P  

Инструменты группы «Перо» можно использовать в сочетании с 

инструментами группы «Фигура» для создания сложных фигур. 

Дополнительные сведения о режимах, которые могут использоваться для 

рисования инструментами группы «Перо», см. в разделе Режимы рисования.  

Примечание.  

Перед началом рисования с помощью инструмента «Перо» можно создать 

новый контур на панели контуров, чтобы автоматически сохранить рабочий 

контур как именованный контур.  

Использование инструмента «Перо кривизны»  

Инструмент «Перо кривизны» позволяет с одинаковой легкостью рисовать 

гладкие отрезки кривых и прямых линий. Создавайте произвольные фигуры в 

своих проектах или задавайте четкие контуры для простой и точной настройки 

своих изображений с помощью этого интуитивно понятного инструмента. Вы 

можете создавать, переключать, редактировать, добавлять или удалять точки 

сглаживания или угловые точки без необходимости переключения 

инструментов.  

1. Выберите «Перо кривизны» в группе инструментов «Перо».  

  
2. Для создания первой опорной точки щелкните или нажмите в любом 

месте документа.  

https://helpx.adobe.com/ru/photoshop/using/drawing.html#drawing_modes
https://helpx.adobe.com/ru/photoshop/using/drawing.html#drawing_modes
https://helpx.adobe.com/ru/photoshop/using/drawing.html#drawing_modes
https://helpx.adobe.com/ru/photoshop/using/drawing.html#drawing_modes
https://helpx.adobe.com/ru/photoshop/using/drawing.html#drawing_modes
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3. Щелкните или нажмите еще раз, чтобы определить вторую опорную 

точку и завершить первый отрезок контура. Щелкните один раз (по умолчанию), 

если необходимо, чтобы следующий отрезок контура был кривым.  

Щелкните дважды, если следующим необходимо нарисовать прямой отрезок.  

Примечание.  

Первый отрезок контура всегда изначально отображается на холсте в виде 

прямой линии. В зависимости от того, какой отрезок вы нарисуете следующим 

(прямой или кривой), Photoshop позднее отрегулирует его вид. Если следующий 

отрезок нарисован кривым, Photoshop гладко искривляет первый отрезок в 

соответствии со следующим отрезком.  

  
4. (Криволинейный контур) С помощью мыши или на сенсорном 

устройстве перетащите указатель, чтобы нарисовать следующий отрезок 

контура. Пока кнопка мыши нажата, оптимизируйте кривизну отрезка. 

Предыдущий отрезок автоматически изменяется для обеспечения гладкости 

кривой.  
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Оптимизируйте кривизну отрезка, пока нажата кнопка мыши.  

5. (Криволинейный контур) Отпустите кнопку мыши, чтобы разместить 

опорную точку и завершить второй отрезок.  

6. Нарисуйте дополнительные отрезки и завершите контур.  
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7. После завершения рисования нажмите клавишу Esc. Вопросы для 

закрепления.  

1. Какие виды графических форматов Вы знаете?  

2. Какой объем графического файла допустим на web – странице? ».  

3. Назовите способы оптимизации графических файлов  

  

  

Практическая подготовка № 2  Работа инструментом прямоугольная 

область в Photoshop  

Цель и содержание: познакомить обучающихся с работой инструмента 

прямоугольная область.  

Методика и порядок выполнения работы  

Для выполнения задания воспользуемся предоставленным уроком.  

Задание   

Инструменты группы «Область» позволяют выделять прямоугольники, 

эллипсы, а также строки и столбцы, состоящие из одного пиксела.  

 1.  Выберите один из следующих инструментов группы «Область».  

Прямоугольная область   

 Создает прямоугольную выделенную область (либо квадратную, если 

нажата клавиша «Shift»).  

Овальная область   

 Создает овальную выделенную область (либо круглую, если нажата 

клавиша «Shift»).  

«Область (горизонтальная строка)» или «Область (вертикальная 

строка)»  

Определяет границу в виде горизонтальной или вертикальной строки 

шириной в один пиксель.  
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 2.  Выберите параметр, определяющий режим работы выделения.  

  
Параметры выделения  

  

A. Новая  выделенная  область B. Добавление  к  выделенной области 

C. Вычитание из выделенной области D. Пересечение с выделенной областью   

3. Укажите значение для параметра «Растушевка» на панели 

параметров. Включает или выключает сглаживание для инструмента «Овальная 

область». См. раздел Смягчение краев выделенных областей.  

4. На панели параметров выберите стиль для инструментов 

«Прямоугольная область» или «Овальная область». Обычный  

Определяет пропорции области при помощи перетаскивания границ. 

Фиксированная пропорция  

Устанавливает соотношение высоты к ширине. Введите значения 

пропорций (десятичные значения являются действительными). Например, для 

того чтобы нарисовать область, ширина которой в два раза больше высоты, 

введите значение 2 для ширины и 1 для высоты.  

Заданный размер  

Указывает значения для высоты и ширины области. Введите количество 

пикселов в целых числах.  

Примечание.  

Кроме пикселов (пикс.) для указания значения высоты и ширины можно 

использовать такие единицы измерения, как дюймы или сантиметры (см).  

5. Для выравнивания выделенных областей по направляющим, сетке, 

фрагментам или границам документа выполните одно из следующих 

действий. o Выберите меню «Просмотр» > «Привязка» либо «Просмотр» > 

«Привязать к», а затем команду из подменю. Область выделения можно 

привязать к границам документа или к различным вспомогательным 

элементам Photoshop, используя подменю «Привязать к».  

6. Выполните одно из следующих действий для выделения области.  

o С помощью инструментов «Прямоугольная область» или «Овальная 

область» перетаскиванием курсора отметьте область, которую необходимо 

выделить.  

o Удерживайте нажатой клавишу «Shift», чтобы выделенная область 

была только квадратной или круглой (отпускать кнопку мыши следует перед тем, 

как отпускается клавиша «Shift»).  

o Чтобы перетащить область из ее центра, удерживайте нажатой  

https://helpx.adobe.com/ru/photoshop/using/adjusting-pixel-selections.html#soften_the_edges_of_selections
https://helpx.adobe.com/ru/photoshop/using/adjusting-pixel-selections.html#soften_the_edges_of_selections
https://helpx.adobe.com/ru/photoshop/using/adjusting-pixel-selections.html#soften_the_edges_of_selections
https://helpx.adobe.com/ru/photoshop/using/adjusting-pixel-selections.html#soften_the_edges_of_selections
https://helpx.adobe.com/ru/photoshop/using/adjusting-pixel-selections.html#soften_the_edges_of_selections
https://helpx.adobe.com/ru/photoshop/using/adjusting-pixel-selections.html#soften_the_edges_of_selections
https://helpx.adobe.com/ru/photoshop/using/adjusting-pixel-selections.html#soften_the_edges_of_selections
https://helpx.adobe.com/ru/photoshop/using/adjusting-pixel-selections.html#soften_the_edges_of_selections
https://helpx.adobe.com/ru/photoshop/using/adjusting-pixel-selections.html#soften_the_edges_of_selections
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клавишу «Alt» (Windows) или «Option» (Mac OS) перед началом перемещения.  

  
Перетаскивание области от угла изображения (слева) или из центра 

изображения (справа) посредством нажатия клавиши «Alt»/«Option» при 

перемещении o Используя инструмент «Область (горизонтальная строка)» или 

«Область (вертикальная строка)», щелкните рядом с областью, которую нужно 

выделить, а затем перетащите область в нужное место. Если выделенная область 

не видна, увеличьте масштаб изображения.  

Вопросы для закрепления.  

1. Назовите способы создания web страниц »?  

2. Какие основные настройки страницы необходимо выполнить перед 

созданием web – страниц?  

  

Практическая подготовка № 3  Работа инструментом кроп (рамка) в 

Photoshop  

  Цель  и  содержание  работы:  ознакомить 

 обучающихся  с правилами пользования инструмента кроп (рамка).  

Методика и порядок выполнения работы  

Для выполнения задания воспользуемся предоставленным уроком.   

Задание  

Кадрирование — это отсечение фрагментов фотографии с целью 

фокусирования или улучшения компоновки. Используйте инструмент «Рамка» 

для кадрирования и выравнивания фотографий в Photoshop. Инструмент «Рамка» 

является неразрушающим. После кадрирования можно восстановить часть 

обрезанного изображения, чтобы подобрать наилучшие границы кадра. 

Инструмент «Рамка» также предоставляет интуитивные методы выравнивания 

фотографии при кадрировании.  

Для всех операций визуальные направляющие обеспечивают 

интерактивный просмотр. При кадрировании или выравнивании фотографии 

доступен предварительный просмотр в реальном времени.  

Кадрирование фотографии  

1. Выберите инструмент «Рамка» ( ) на панели инструментов. По 

краям фотографии появятся границы кадра.  
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2. Нарисуйте новую область кадрирования или перетащите ручки угла 

и краев кадра на фотографии.  

3. (Необязательно) Укажите параметры инструмента «Рамка» с 

помощью панели «Управление».  

 

Выберите соотношение сторон или размер прямоугольника кадра. Вы 

можете выбрать готовый набор параметров, задать новые параметры или 

определить пользовательский набор параметров для последующего 

использования.  

Параметры наложения  

Выберите вид направляющих, задающих границы кадра изображения. 

Доступны следующие виды направляющих: «Правило 1/3», «Сетка» и «Золотое 

сечение». Чтобы просмотреть все параметры, нажмите «O».  

Параметры инструмента «Рамка»  

Выберите меню «Настройки» (значок шестеренки), чтобы указать 

дополнительные параметры инструмента «Рамка».  

Использовать классический режим  

Включите эту настройку, чтобы инструмент «Рамка» работал как в 

предыдущих версиях Photoshop (CS5 и более ранних).  

Просмотр автоматического центрирования  

Включите эту настройку, чтобы поместить просматриваемое изображение 

в центр холста.  

Показать отсеченную область  

Включите эту настройку, чтобы отобразить область, удаляемую при 

кадрировании. Если эта настройка отключена, показывается только результат 

кадрирования.  

Включить экран кадрирования  

Используйте экран кадрирования, чтобы наложить оттенок на удаляемые 

области. В этой настройке можно выбрать цвет и прозрачность экрана. Если 

включена настройка Автоматическая настройка непрозрачности, 

прозрачность повышается при редактировании границ кадра.  

Удаление обрезанных пикселей  

Отключите эту настройку, если необходимо неразрушающее 

кадрирование, при котором пикселы вне рамки сохраняются. Неразрушающее 

  
Параметры инструмента «Рамка» в Photoshop   

  

A.   Меню   «Пропорции»   B.   Поменять   местами   ширину   и   в ысоту   C.   Параметры   

наложения     

Размер   и   пропорции   
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кадрирование не приводит к удалению из памяти частей изображения. Если 

после кадрирования щелкнуть изображение, можно увидеть области вне текущей 

границы кадра.  

Включите эту настройку, чтобы удалить пикселы, лежащие за пределами 

границ кадра. Удаленные пикселы будут потеряны и не смогут использоваться 

при последующей корректировке кадра.  

Примечание.  

Щелкните прямоугольник кадра правой кнопкой мыши для доступа к 

контекстному меню параметров кадрирования.  

Нажмите клавишу Enter (в Windows) или Return (в Mac OS), чтобы 

выполнить кадрирование фотографии.  

 

Заливка с учетом содержимого при кадрировании  

Впервые в выпуске Photoshop CC 2015.5  

В Photoshop теперь используется технология учета содержимого для 

интеллектуального заполнения пробелов при использовании инструмента 

«Рамка» для выравнивания или поворота изображения либо расширения холста 

за пределы исходного изображения. Выполните следующие действия.  

1. На панели инструментов выберите инструмент «Рамка» ( ). По 

краям фотографии появятся границы кадра.  

2. На панели «Параметры» выберите «С учетом содержимого». 

Прямоугольная рамка по умолчанию расширяется на все изображение. 

перетаскивания вдоль рамки. Можно также развернуть холст больше 

первоначального размера изображения.  

4. После получения желаемого результата нажмите кнопку  на панели 

«Параметры», чтобы подтвердить операцию кадрирования. Photoshop 

интеллектуально заполнит белые области или пробелы на изображении.  

 заданий к практической работе и порядка их выполнения.  

Практическая подготовка № 4 Создание текстур в Photoshop. 

Металлическая текстура и шляпки винтов.  

  

Цель и содержание: познакомить обучающихся со способами создания 

текстур.  

Задание  

 В  программе  Photoshop,  создайте  металлическую  текстуру.  

 
  

3.  Выровняйте или поверните изображение с помощью маркеров  



  13  

Воспользуйтесь уроком приведенным ниже  

  

  
В этом уроке вы научитесь создавать нужный градиент и сохранять его для 

дальнейшего использования.  

Шаг 1.  

Создайте новый документ в режиме RGB размером 15х10 см и 

разрешением 300 пикс/дюйм.  

  
Шаг 2.  

Нажмите клавишу «G» что бы выбрать инструмент градиент, после чего 

щелкните на значке градиента на панели опций, что бы отобразить диалоговое 

окно выбор градиента. Мы создадим нужный градиент сами.  

Настройки цвета левой точки:  
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Шаг 3. Сохраним сделанный градиент под именем Медь.   

  
  

  

Настройки цвета средней точки:   

  
  

  

Настройки цвета правой точки:   
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Шаг4.  

В панели опций включаем зеркальный градиент.  Установите инструмент 

градиент у самого верхнего края и перетащите его вниз под небольшим углом. 

Но не до самого края и отпустите кнопку мыши.  
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Шаг 5.  

Выберите команду Фильтр—Шум—добавить шум. Задайте параметры как 

на скриншоте.  

  
Шаг 6.  

 Выберите  команду  Фильтр—Размытие—Размытие  в  движении.  

Параметры как на скриншоте.  
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Шаг 7.  

У нас получилась имитация металла(переименуйте слой в пластина), но у 

неё не очень хорошие края. Исправим это. Создайте копию слоя пластина 

сочетанием клавиш «Ctrl + j» и включтв инструмент Трансформация, удерживая 

нажатой клавишу Shift потяните за любой угол немного увеличив документ, что 

бы исчезли некрасивые края. Примените Трансформацию, нажав клавишу Enter. 

Шаг 8.  

Теперь будем создавать шляпки винтов.  Создайте новый слой. Нажмите 

комбинацию клавиш  «Shift+ M», что бы выбрать инструмент Овальная область, 

после чего, удерживая нажатой клавишу «Shift», нарисуйте окружность в центре 

изображения. Создайте большую окружность, её потом можно будет уменьшить 

до нужного размера.  

  

  
Шаг 9.  
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Нажмите клавишу «G», что бы открыть инструмент градиент, после чего 

выберите градиент Медь. И сделайте действие, как на скриншоте (для этого 

эффекта нам нужен переход от светлого к темному). Сдвиньте средний ползунок 

в лево.  

  
Теперь включите радиальный градиент. Щелкните в центре окружности и 

перетащите градиент вправо. Снимите выделение комбинацией клавиш «Ctrl 

+D». Назовите слой «Шляпка».  

  
Шаг 10.  

Создайте новый слой и назовите его «Бороздка». Нажмите комбинацию 

клавиш  «Shift+ M», что бы выбрать инструмент Прямоугольная область. 

Нарисуйте длинный вертикальный прямоугольник. Щелкните на образце 

переднего плана, выберите цвет # 7a5023.   
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После чего щелкните комбинацию клавиш «Alt + BackSpase», что бы 

залить выделенную область.  

  
Шаг 11.  

Создайте копию слоя бороздка. Выделите прямоугольник таким образом: 

наведите указатель мыши на миниатюру слоя «бороздка копия» (указатель 

превратится в руку), и нажав клавишу «Ctrl», щелкните мышкой на миниатюру 

слоя. Выберите цвет переднего плана  # 4e361d и комбинацией  клавиш «Alt + 

BackSpase»,  залейте прямоугольник этим цветом.  

  

  
Шаг 12.  

 Нажмите клавишу «V», что бы выбрать инструмент перемещение , после 

чего воспользуйтесь клавишами со стрелками и переместите слой на шесть 

пикселей  влево.  
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Шаг 13.  

Создайте копию «бороздка копия»  и залейте её еще более темным цветом. 

У нас образовался слой «бороздка копия 2» и его надо опустить под слой 

«бороздка», а затем, нажмите клавишу «V», что бы выбрать инструмент 

перемещение , после чего воспользуйтесь клавишами со стрелками и 

переместите слой на шесть пикселей  вправо.  

  
Шаг 14.  

Теперь надо склеить в один  все слои с названием «бороздка».  Выделите 

самый верхний слой и сочетанием клавиш «Ctrl+ E» по очереди склейте три этих 

слоя.  
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Шаг 15.  

Затем выделите слои  Шляпка и Бороздка и щелкнув по ним правой 

клавишей мышки найдите строку  Связать слои и сделайте это. Сейчас мы 

выровняем бороздку по центру шляпки.  Сделайте как на скриншоте.  

  

  
Шаг 16. Прямоугольник выровнялся по центру окружности и очень важно 

убрать связи для следующего действия. Отменяются они тем же способом, как и 

применялись. Надо выбрать строку  Отменить связь слоев. Как вы заметили, 

прямоугольник сильно выступает за окружность это можно исправить так:  
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наведите указатель мышки между слоями «бороздка» и «шляпка» и нажмите 

клавишу «Alt» . должен появиться значок, состоящий из двух кружков черного и 

белого, и стрелкой влево, щелкните левой клавишей мышки и получится так.  

  
Шаг 17.  

Важно что бы активным был слой «шляпка».  

Теперь придадим шляпке немного объема. Откройте  Параметры 

наложения и выставьте такие значения как на скриншоте.  

  
Должно получиться так.  
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Шаг 18.  

Включаем инструмент Трансформация и изменяем масштаб до нужного 

размера. И копируем нужное количество шляпок сочетанием клавиш «Сtrl+  

Alt».  

  

  
Урок закончен.   

  

Практическая подготовка № 5  Урок по созданию каменной текстуры  

Цель и содержание: познакомить обучающихся со способами создания 

текстур.  

Задание  

В программе Photoshop, создайте каменную текстуру. Воспользуйтесь 

уроком приведенным ниже  
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Шаг 1.  

Создайте новый холст размером 15х10 см, 300 пикс/дюйм и заленйте его 

черным цветом.  

Шаг 2.  

Создание кругов. Установите для кисти белый цвет и жесткость 100%.  

Нарисуйте несколько пятен.  

  
Шаг 3.  

Изменяя размеры кисти, добавьте больше кругов на холст. Ваши круги не 

должны накладываться друг на друга.  

  

Шаг4.  

Работа с фильтром Пластика. Выберите,  Фильтр – Пластика— 

Инструмент Деформация  
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Кликните внутри белых кругов и отведите мышь немного в сторону, 

чтобы деформировать объекты. Размер инструмента деформации должен 

быть немного меньше круга. Вы должны получить такой результат.  

  

  
Шаг 5.  

 Продолжаем  деформацию  

Продолжайте работать инструментом деформации и сделайте примерно так. 
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Шаг 6.  

Название  слоя Кликните дважды на фоновом слое, который вы 

обрисовывали и в появившемся окне назовите его «Камни».  

  

Шаг 7.  

Дублирование  слоя Сделайте копию слоя «Камни» и назовите её 

«Тень». Установите Режим наложения – Умножение:  

  

  
  

Шаг 8.  

Размытие текстуры. Примените фильтр Размытие по гауссу:  
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Шаг 9.   

Наложение цвета. В слое «Камни» перейдите в меню Стилей Наложение  

цвета    

  
  

Наложение цвета (Режим – Умножение) и настройте так:  
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Окно не закрывайте!  

  

Шаг 10. Наложение узора. Выберите узор Гранит и следующие 

настройки:  

  

  
  

Шаг 11.  

Добавим свечения. Создайте новый слой и назовите его «Свечение». 

Маленькой кистью с жёсткостью 0% белым цветом, сделайте мазки на камнях и 

понизьте непрозрачность слоя до 25%.  
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Шаг 12.  

Добавление теней. Создайте ещё один слой «Тень». Выберите кисть 

чёрного цвета с жёсткостью 90% и обрисуйте нижние части камней:  

  

  
  

Шаг 13.  

Настройка теней. Уменьшите непрозрачность до 12%  
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Практическая подготовка № 6  Надпись граффити на кирпичной стене  

     Цель и содержание работы: ознакомить обучающихся с работой 

инструмента Текст в программе Adobe Photoshop.  

Методика и порядок выполнения работы  

Для выполнения задания воспользуемся предоставленным уроком.     

Задание  

Вам предстоит выполнить цветной текст граффити на кирпичной стене в 

программе Adobe Photoshop.  

  
Изображение, с которым будем работать это обычная кирпичная стена.  

Шаг 1.  

Откройте изображение. Прежде чем мы начнём работу над текстом, 

создадим карту смещения, она пригодится нам в дальнейшем. Карта смещения, 

это обычно высококонтрастная черно-белая версия вашего изображения, которая 

поможет «подогнать» наш текст, соответствуя изгибам кирпичам стены.  

  

Шаг 2.  

Начнём с преобразования изображения со стеной в чёрно-белое. Это 

можно сделать быстро с помощью комбинации клавиш Ctrl+ Shift+ U.  
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Шаг 3.  

После обесцвечивания изображения нам необходимо повысить его 

контраст. Есть несколько способов достигнуть этого, но мы воспользуемся 

Уровнями (Levels), чтобы усилить тени и повысить света. С такими настройками 

как на скриншоте.  

  

  
  

Шаг 4.  

Полученное высококонтрастное чёрно-белое изображение стены и 

послужит нам как карта смещения. На данный момент, вам нужно сохранить это 

изображение как файл PSD. Очень важно, что он сохраняется именно в PSD, 

иначе вы не сможете выбрать его в дальнейшем.  

  

  
  

Шаг 5.  

Теперь займёмся текстом. Откройте снова цветное изображение с 

кирпичной стеной, не перепутайте с файлом для карты смещения.   

Вы можете свободно использовать любой шрифт, который хотите, но 

лучше, если этот шрифт будет в стиле граффити. Можете написать своё имя.  
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Обычно, граффити не рисуется одним цветом, и надпись содержит 

градиенты, тени и границы. В этом нам помогут стили слоя, с помощью которых 

мы добавим все эффекты прямо на один слой с текстом. Настройки стилей ниже 

на скриншотах, но не стесняйтесь экспериментировать, чтобы получить 

результат, который вам понравится больше.  

  

Шаг 6. Прежде чем давить кнопку ОК, сделайте все четыре 

стиля!  

Наложение градиента (Gradient Overlay)  

  
  

Шаг 7.  

Обводка (Stroke)  
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Шаг 8.  

Внутренняя тень (Inner Shadow)  

  
Шаг 9.  

Внешнее свечение (Outer Glow)  

  
Теперь ОК.  

Как только вы применили все стили, у вас должен быть примерно такой 

результат.  
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Шаг 10.  

Теперь, когда текст готов, займёмся применением карты смещения, 

которую мы создали ранее.  Прежде чем добавить фильтры, преобразуем слой с 

текстом в смарт объект. Сделать это можно в меню Фильтр – Преобразовать в 

смарт -обьект (Filter – Convert for smart filters). Это позволит вам редактировать 

текст и цветовую гамму на более позднем этапе, если это необходимо!  

  

Шаг 11.   

А теперь идём в меню Фильтр – Искажение – Смещение (Filter – Distort  

– Displace). И применяем такие настройки.  

  

  
Горизонтальная и вертикальная шкала значений будет контролировать, 

насколько эффективно смещение. Чем выше значение, тем большее искажение 

применяется к слою. Нам большое искажение не нужно, поэтому значений 6 

вполне хватит. После нажатия на кнопку ОК, вы перейдёте к выбору PSDфайла, 

сохраненного ранее. Шаг 12.  
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Шаг 13.  

Когда файл выбран и открыт, вы должны увидеть результат, который 

похож на тот, что ниже на скриншоте. Программа применит чёрно-белое 

изображение как карту смещения и исказит слой, создавая впечатление, что это 

часть стены. Очевидно, что смещение сделало свою работу, исправив 

совершенно прямые границы текста, но этого недостаточно.  

  

  
  

Шаг 14.  

Теперь нужно сделать надпись на стене более реалистичной. Есть 

несколько способов, которыми это можно сделать, в том числе 

экспериментировать с различными режимами наложения, но мы воспользуемся 

способом, Наложение, если (Blend If). Чтобы получить доступ к этой функции, 

откройте окно стилей слоя в меню Слои – Стиль слоя – Параметры наложения 

(Layer > Layer Styles > Blending Options).  
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Настройки функции: Наложение, если - содержит два бара. Один для 

текущего слоя, а второй для слоя под ним.  Оба содержат маркеры для теней и 

светов, которые позволяют смешивать текущий и/или подлежащий слой. Мы 

будем использовать нижний слайдер, чтобы работать с подлежащим слоем, то 

есть кирпичной стеной.  

Расположите маркеры как показано на скриншоте – тени вправо, света 

влево. Вы увидите, как слой с кирпичной стеной смешается с текущим слоем.  

  
Перетащив просто маркеры, мы как правило получаем средний результат, 

если вас устраивает, то можете так и оставить, хотя можно сделать ещё лучше.  

Для этого нужно разделить маркеры, зажав клавишу Alt и потянув его 

половинки. Эффект смешивания будет намного качественнее.  
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Преимущество использования функции Наложение, если по сравнению с 

режимами наложения состоит в том, что вы не теряете исходные цвета 

изображения. Изменение режимов наложения имеет тенденцию изменять цвет 

ваших слоев, чтобы смешать их. Конечно вы можете экспериментировать, чтобы 

видеть, какой метод Вам больше подойдёт.  

  
Урок закончен!  

Практическая подготовка №7 Создание фотоэффектов в Photoshop. 

Панорамное изображение на 360  

Цель и содержание: познакомить обучающихся со способами создания 

фотоэффектов в Photoshop .  

Цель и содержание: ознакомить обучающихся с навыками создания 

фотоэффектов Задание  

Для выполнения практической работы необходимо использовать 

приведенные примеры.  

В этом уроке вы научитесь работать с фотографиями и создавать 

фотоэффекты  
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Шаг 1. Открыть панорамное изображение в Photoshop.  

  

  
  

  

Шаг 2. Изменить размер изображения. Изображение –Размер изображения 

в открывшимся окне, изменяем размер с меньшего на больший. В данном случае 

меняем только высоту изображения  
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Должен получиться квадрат с сильно вытянутым изображением  

  

  
  

Шаг 3. Надо повернуть изображение на 180. Изображение -- Вращение 

изображения  -- 180. Рис.№5  
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Шаг 4.Сделать изображение по кругу. Выбираем : Фильтр –Искажение – 

Полярные координаты -- в открывшимся окне выбираем  --прямоугольные в 

полярные. ОК  

  

   
   

Должно получиться как на рис.№7!  
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рис.№7  

Ретушируем стыки.  

Если пропустить шаг 3, то получится вариант как на рис.№8  

  
  

рис.№8  

  

  

Практическая подготовка № 8  Обработка фотографий в Photoshop. 

Рисунок из фотографии  

Цель и содержание: ознакомить обучающихся с возможностью 

декоративной обработки фотографий.  

Задания для выполнения лабораторной работы  

Для  выполнения  практической  работы  необходимо 

 использовать приведенные примеры.  
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В этом уроке вы научитесь работать с фотографиями и создавать 

фотоэффекты  

  

  
Шаг 1.  

Откройте  изображение,  к  которому  будете  применять 

 эффект.  Дублируйте его два раза. Слой  Фон мы использовать не будем, 

поэтому отключим видимость слоя Фон. У нас осталось два слоя Слой 1 и Слой 

1 копия. Отключим видимость слоя Слой 1 копия - мы вернемся к нему позже, а 

пока будем работать со Слой 1.  

Шаг 2.  

Надо выделить границы объектов. Воспользуемся фильтром Умное 

размытие. Именно он позволяет получить максимальное количество границ. 

Фильтр—Размытие—Умное размытие.  

  
Шаг 3.  
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Теперь несколько смягчить контраст линий. Для этого воспользуйтесь 

Фильтр—Размытие—Размытие по Гауссу с настройкой: радиус 3,0 пикс.  

Шаг 4.  

Включите видимость слоя Слой 1 копия и примените к нему  Фильтр— 

Имитация—Цветной  карандаш.  

  

  

  
  

  

Шаг 5.  

Затем в палитре Слои измените режим наложения этого слоя на Жесткий 

свет. Эффект готов. Теперь два видимых слоя можно «склеить» в один 

сочетанием клавиш Ctrl+E.  

   
Готово!  

  

  

Практическая подготовка № 9 Создание картонной бирки в Photoshop  

     Цель и содержание: познакомить обучающихся с правилами создания 

картонной бирки в программе Adobe Photoshop.  
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    Задание  

Создайте в фотошопе картонную бирку  

Для выполнения задания воспользуемся предоставленным уроком.  

Создайте в фотошопе картонную бирку  

  

  
  

Шаг 1  

Начнем работу с создания нового документа  

  
  

Шаг 2  

На новом слое (назовем его бирка) при  помощи инструмента «Перо» 

создайте вот такую  заготовку для нашей бирки.  Это не займет много времени, 

так как контур состоит из прямых линий, а потом  закрасьте ее любым цветом.  

Создайте копию слоя «бирка».  
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Шаг 3  

Теперь надо придать бумажную фактуру нашей бирке. В «Стилях слоя» 

выберите «Параметры наложения» и задайте два следующих стиля  с 

параметрами.  
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Не закрывая стили, переходите на следующий параметр.  

  
И теперь давим ОК.  

  

Мы придали фактуру и цвет бирке. И сочетаниями клавиш «CTRL+E» 

делаем  объединение  слоёв с бирками.   
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Шаг 4  

Создаем отверстие для нитки. На слое с биркой рисуем круг при помощи 

инструмента «Эллипс» с такими настройками! Что бы круг получился ровный, 

при рисовании, удерживайте нажатой клавишу «Shift».  

 
После того как круг готов, щелкните в центре правой клавишей и выберите 

следующие действие:  

 
Поставьте Радиус растушевки: 0. ОК и нажмите клавишу «Delete». 

Отверстие готово!  
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Шаг 5  

Придадим не много  тени и объема бирке. В «Стилях слоя» выберите 

«Параметры наложения» и задайте два следующих стиля  с параметрами.  

  
 Не  закрывая  стили,  переходите  на  следующий  параметр. 

  
И теперь давим ОК.  

Шаг 6  

Этот шаг мы делаем на слое «Бирка»  

Выберите инструмент «Эллипс» и создайте круговое выделение на том 

месте, где должно находиться усиленное кольцо (вокруг отверстия для нитки).   
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 Дублируем выделение сочетанием клавиш «Ctrl+J». У нас получился 

новый  слой который назовем «Кольцо». Мы убираем эффекты от предыдущего  

 

Теперь нам надо закрасить усиливающее кольцо цветом  #706340.  Для 

этого мы его выделяем наведя указатель мышки на иконку слоя кольцо и 

щелкаем по ней одновременно давя клавишу «Ctrl».   

 
Не убирая выделение давим сочетание клавиш «Alt+BackSpace» и наше 

кольцо закрашенно. Теперь слой с кольцом надо продублировать.  

  

  

слоя,   они нам не нужны, так как мы применим другие эффекты.   
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Шаг 7  

Теперь добавим стили к усиливающему кольцу. Со следующими 

параметрами.  

  
Давим ОК.  

И сочетаниями клавиш «CTRL+E»  объединяем слои «Кольцо».  

  

Шаг 8  

Время привязать к нашей бирке шнурок. Сделаем это в несколько этапов 

из трех отдельных контуров, которые будем наводить кистью. Переключитесь на 

Кисть (Brush Tool) нажатием клавиши B и задайте ей нужные параметры 

(Жесткость — 100%, Размер — 8px).   
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Шаг 9  

Создайте новый слой под названием Шнурок 1”. Смените основной цвет 

на #735e47 и нажмите P, чтобы переключиться на «Перо». Теперь нанесите 

первую часть нашего шнурка на рисунок.  

  

  
  

Шаг 10  

Находясь с выбранным инструментом «Перо», нажмите правой кнопкой 

мыши на созданном контуре и выберите Выполнить обводку контура. Отметьте 

в диалоговом окне пункт Кисть, убедитесь в том, что не выбран пункт Карандаш 

и нажмите OK. Нажатие клавиш Ctrl + H позволит спрятать созданный контур и 

посмотреть на то, что получилось.  
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Шаг 11  

Повторите шаги 9 и 10 на новом слое , назвав его  Шнурок 2.  

  
Шаг 12  
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Последним штрихом будет создание петли, которая проходит сзади биркии 

обхватывает спереди наш шнурок. Этот слой назовите «Петля» Я нарисовала 

петлю, которая перекрывает ярлык — мы уберем лишнее на 13 шаге.  

  

  
Шаг 13  

Нажмите M для выбора инструмента «Прямоугольная область» с 

растушевкой 0%, убедитесь, что у вас появился именно инструмент 

«Прямоугольная область», затем создайте выделение до границы тела бирки. 

Находясь на слое «Петля» жмем Delete, чтобы убрать ненужные части петли.  

Затем отмените выделение нажатием Ctrl + D.  

  
Шаг 14  
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Чтобы придать реалистичности добавим к шнурку стили Тень и Тиснение. 

Стили можно сначала применить к любой из частей шнурка, а затем скопировать 

их на остальные.  

  
  

  
  

Шаг 15  
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Сейчас наша бирка уже готова. Пришло время поместить на неё 

какойнибудь графический элемент.  

Я Нарисовала звезду на новом слое «Звезда» поместив его над слоем  

«Бирка», закрасила её красным цветом.  

  

  
Затем изменила наложение слоя на «Яркий свет», понизила 

непрозрачность до 85%, открыла настройку «Цветовой тон/Насыщенность» и 

поиграла с параметрами, достигнув желаемого результата.  

  

  
Шаг 16  
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И дополнить нашу бирку надо текстом.  

  

  
  

  

Практическая подготовка № 10  Создание коллажей  

     Цель и содержание работы: ознакомить обучающихся с разными 

техниками создания коллажей в программе Adobe Photoshop.  

    Задание  

Создайте коллажи в разных техниках  

Для выполнения задания воспользуемся предоставленным уроком.  

  

Коллаж № 1 Наложение изображения  

  
Шаг 1.  
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Откройте изображение в режиме RGB и выберите черный цвет переднего 

плана.  

  
  

Шаг 2.  

Откройте второе изображение, которое хотите использовать в коллаже. 

Нажмите клавишу «V», что бы выбрать инструмент  Переместить, после чего 

переместите изображение вверх по отношению фонового в исходном документе. 

Убедитесь в том, что перетащенный слой перекрывает значительную часть 

фонового.  

  

  
  

Шаг 3.  
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Щелкните на значке,  Добавить слой-маску  в нижней части палитры Слои. 

Изображение не изменится, но в палитре появится новый значок, 

представляющий маску слоя.   

  
  

Шаг 4.  

Щелкните на инструмент Градиент, установите Линейный градиент, 

откройте диалоговое окно (выбор градиента) и щелкните на двух цветном 

градиенте.   

  
  

Шаг 5.  

Установите перекрестие градиента у верхнего края изображения, зажмите 

левую клавишу мышки и перетащите в направлении сверху вниз.  
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Шаг 6.  

Используйте инструмент до тех пор, пока не получите нужного эффекта. 

Если хотите контролировать наложение изображения, то можно рисовать прямо 

по маске, нажав клавишу «В» кисть, выбрав большой размер с мягкими краями. 

Если используется черный цвет в качестве цвета переднего плана, то будет 

проступать нижнее изображение. А если белый цвет, то верхнее изображение 

будет налагаться на фоновое.  
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Коллаж №2 Одно изображение разбитое на несколько фотографий  

  

  
  

Шаг 1.   

Откройте любое изображение из урока по света - коррекции. Создайте 

копию. Если на рабочем пространстве отсутствует линейка, то включите её 

сочетанием клавиш «Ctrl+R» и при помощи направляющих разделите ваше 

изображение (в данном случае) на шесть равных квадратов 5х5 см.  
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Шаг 2. Начните выделять квадраты инструментом Прямоугольная область 

или клавиша «М». Когда вы обвели квадрат, то должны появиться «бегущие 

муравьи».  

  
  

Шаг 3.  

Нажмите сочетание клавиш «Ctrl+J» и выделенная область образуется на 

новом слое, а «бегущие муравьи» исчезлт.  

  
  

Шаг 4.  

Вернитесь на Слой 1(сделайте его активным) и выделите следующий 

квадрат, так же как и первый. Важно! Не забывайте, после каждого нового слоя 

с квадратом, возвращаться на Слой 1. Продолжайте таким способом выделять 

все шесть квадратов. У вас должно получиться шесть слоёв с квадратами. 

Направляющие теперь можно убрать - они уже не нужны.  
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Шаг 5.  

Сделайте активным Слой 7 и в низу палитры Слои выберите Добавить 

стиль слоя-обводка.   

  

  
  



  63  

С параметрами как на картинке.  

  
  

Шаг 6.  

Надавите, правой клавишей мышки на Слой 7, и выберите строку 

Скопировать стиль слоя.  

  

   
  

Шаг 7.  
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Теперь выделите слои 2-6 и надавите, правой клавишей мышки на любом 

из выделенных слоев и найдите строку Вклеить стиль слоя. Надавите на неё.  

  
  

Шаг 8.  

Создадим небольшие наклоны получившимся картинкам. Для этого 

включите инструмент Трансформация «Т» и наведя указатель мышки на угол, 

немного наклоните картинку. Надавите клавишу «Enter».   

  
  

Шаг 9.  

Так проделайте с оставшимися квадратами. Для того, что бы наш коллаж 

выделился, под слоями с квадратами, создайте пустой слой и залейте его любым 

не ярким цветом.  
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Шаг 10.  

Уменьшим немного коллаж, так как при повороте картинок углы ушли за 

рамку. Выделите слои 2-7 и включите трансформацию и потяните за угол к 

центру. Вы уменьшили коллаж до размера файла.  

  

  
  

Попробуйте усложнить задание и создать такой коллаж из разных 

фотографий.  

  

  

Практическая подготовка № 11  Рисунки фруктов, выполненные в 

программе Photoshop   

     Цель и содержание работы: ознакомить обучающихся с техникой 

создания в программе Adobe Photoshop.  
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    Задание  

При помощи фигур, создайте небольшой фруктовый набор  

Для выполнения задания воспользуемся предоставленным уроком.  

В этом уроке вы познакомитесь с простой техникой создания фруктов, 

используя программу Photoshop.  Фрукты  

Мы создадим апельсин, банан и виноград.  

  
Как нарисовать Апельсин Шаг 1  

Создайте новый документ в программе Photoshop, для этого идём Файл – 

Новый  (File>New) 15см x 15см (300 dpi). Шаг 2  

Создайте новый слой. С помощью инструмента Овальная область 

(Elliptical Marquee Tool), нарисуйте круг. Залейте круг оранжевым цветом.  

        
Шаг 3  

Добавьте к данному слою немного шума Фильтр – Шум – Добавить шум 

(Filter>Noise>Add Noise). За счёт данного фильтра мы создадим некую текстуру, 

которая нам понадобится для дальнейшей обработки в следующем шаге.  
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Шаг 4  

Далее, идём, Фильтр- Имитация – Целлофановая упаковка 

(Filter>Artistic>Plastic Wrap) и применяем следующие значения:  

  
Шаг 5  

Дважды щёлкните по слою, чтобы появилось окно Стили слоя (Layer 

Styles), далее, примените следующие опции:  



  68  

  

  
Результат должен быть, как скриншоте ниже.  

  
Шаг 6  

Создайте новый слой. Выберите инструмент Кисть (Paint Brush Tool), в 

настройках кисти установите кисть (кисть ‘звёздочка 250 пикселей’).  
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Не перемещая кисть, просто щёлкните 3-4 раза, чтобы получилась красивая 

тёмная звёздочка;  

  
Шаг 7  

Трансформируйте звёздочку с помощью опции Деформация (Warp Mode), 

для этого идём Редактирование – Трансформация – Деформация 

(Edit>Transform>Warp) и далее, деформируйте звездочку, пока у вас не 

получится желаемый «апельсиновый пупок». Непрозрачность установите на 

50%.  

   

 Для  добавления  некоторых  деталей,  используйте  инструмент  

Осветлитель и Затемнитель  (Dodge and Burn Tools) для создания светотеней. 

Например:   
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Как нарисовать Банан Шаг 1   

Создайте новый документ в программе Photoshop, для этого идём Файл – 

Новый  (File>New) 17см x 10см (300 dpi).  

Шаг 2  

Создайте новый слой. С помощью инструмента Прямоугольная область 

(Rectangular Marquee Tool), создайте прямоугольник. Залейте его жёлтым 

цветом.  

  
Шаг 3  

Ещё раз создайте новый слой. Создайте второй прямоугольник, как 

показано на скриншоте ниже. Залейте его чёрным цветом.  

  
Шаг 4  

Далее, идём Фильтр – Рендеринг – Волокна (Filter>Render>Fibers), а 

затем применяем следующие значения (не забудьте установить белый и чёрный 

цвет в качестве цветовых оттенков переднего и заднего плана):  
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Результат должен быть, как скриншоте ниже.  

  
Шаг 5  

Поверните, а также примените трансформацию (Ctrl + T) к слою с 

текстурой волокна в соответствии с размерами желтого прямоугольника.  

Поменяйте режим наложения для слоя с текстурой волокна на Умножение 

(Multiply).  

  
Шаг 6  

Удерживая клавишу Alt + щёлкните между слоем с текстурой волокна и 

слоем с жёлтым прямоугольником, чтобы преобразовать слой с текстурой 

волокна в обравочную маску. Уменьшите непрозрачность слоя с текстурой 

волокна до, примерно, 6%.  
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Шаг 7  

Выделите оба слоя, а затем слейте их вместе (Ctrl + E). С помощью 

Деформации (Warp Mode), придайте жёлтому прямоугольнику форму банана, 

для этого идём Редактирование – Трансформация – Деформация 

(Edit>Transform>Warp):  

  
Шаг 8  

Доработайте форму с помощью опции Деформации (Warp Mode), на 

кончике банана по мере необходимости. Также, с помощью инструмента Ластик

(Eraser tool), можно придать необходимые грани:  
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Шаг 9  

С помощью инструментов Осветлитель и Затемнитель (Dodge and 

Burn Tools), создайте светотени на нашем банане. Сфокусируйтесь на кончиках 

банана, они обычно намного темнее.  

  
Шаг 10  

Создайте новый слой. Выберите инструмент Овальная область  

(Elliptical Marquee Tool), чтобы создать овальную область. Залейте созданную 

овальную область белым цветом. Убедитесь, чтобы белый овал закрывал чуть 

меньше, чем на половину поверхность банана, как показано на скриншоте ниже:  

  
Шаг 11  

Преобразуйте данный слой с белым овалом в обтравочную маску к слою с 

бананом (Alt+щёлкните между двумя слоями в палитре слоёв). Также, поменяйте 

режим наложения для данного слоя на Осветление (Screen), а также уменьшите 

непрозрачность слоя до 25%.  
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Шаг 12  

При необходимости, вы можете применить размытие или инструмент 

Палец (smudge) к кромке овала, чтобы смягчить кромку для естественности. 

Также, для детализации, вы можете добавить к изображению банана оттенки 

зелёного цвета (создайте новый слой и на новом слое, с помощью мягкой кисти 

бледно-зелёного цвета, прокрасьте штрихами по поверхности банана. Не 

забудьте преобразовать данный слой в обтравочную маску и поменять режим 

наложения на Цветность (color). А затем, примените Размытие по Гауссу 

(Gaussian Blur), чтобы смягчить цвет).  

  

  
Как нарисовать Виноград Шаг 1  

Создайте новый документ в программе Photoshop, для этого идём Файл – 

Новый  (File>New) 15см x 15см (300 dpi).  

  

Шаг 2  

Создайте новый слой. С помощью инструмента Овальная область 

(Elliptical Marquee Tool), нарисуйте овал. Залейте нарисованный овал серым 

цветом средних тонов (например: R=91 G=91 B=91)  
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Шаг 3  

Дважды щёлкните по слою, чтобы появилось окно Стили слоя (Layer  

Styles), далее, примените следующие опции:  

Глобальное Освещение (Global Lights)!  

Очень важно, чтобы вы обратили внимание, когда ставить галочку в 

окошке Глобальное Освещение (Global Lights), а когда нет.  
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Ваша виноградинка должна выглядеть, как на скриншоте ниже:  

  
  

Шаг 4  

Продублируйте слой с виноградинкой столько раз, сколько вы пожелаете 

(для дублирования изображения, просто удерживайте клавишу Alt + 

перемещайте мышкой копию изображения виноградинки). Также для 
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разнообразия, вы можете развернуть (Ctrl+ T) виноградинки в различных 

направлениях.  

   
  

Итоговый результат  

  

  
  

  

   

Практическая подготовка № 12  Создание эффекта теснения на бумаге  

     Цель и содержание работы: ознакомить обучающихся с техникой 

эффекта теснения на бумаге в Photoshop.  

Для выполнения задания воспользуемся предоставленным уроком.  

    Задание  

Создайте по образцу эффект тиснения на бумаге   

Для выполнения работы необходимо использовать приведенные ниже 

образцы.  

В этом уроке мы будем создавать реалистичный эффект тиснения на 

бумаге в Adobe Photoshop. Вы можете применить эффект к вашему лого, или 

любому другому объекту, или же начать с создания эмблемы, с которой будете 

работать. Далее нам понадобится лишь один слой со стилями слоя. Обязательно 
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попробуйте эффект на разных типах бумаги, а также вообще на иных текстурах 

типа камня, дерева или кожи.  

  
Для начала нам нужна текстура бумаги, на которой мы будем делать наш 

эффект. Поместите ее в новый слой нового документа. Это белая текстура, мы 

сможем выкрасить ее в любой цвет.  

  
Создаем изображение  

Поместите в новом слое ваш логотип, текст или изображение, к которому 

хотите применить эффект. Вы можете использовать что угодно: текстовые слои, 

векторные изображения или даже обычные вырезанные растровые объекты. В 

нашем случае это текстовые слои, для которых использован шрифт Cambria и 

лавровые веточки.  
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Создаем эффект  

Кликните дважды по одному из слоев, к которому  хотите применить 

эффект. Откроется окно стиля слоя. В нем укажите параметры как на картинках 

ниже, применив стили Inner Shadow/Внутренняя тень, Inner Glow/Внутреннее 

свечение, Bevel and Emboss/Тиснение и Color Overlay/Перекрытие цвета.  

  
В итоге у вас должно получиться примерно следующее:  
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Чтобы указать эти же стили остальным слоям, кликните по уже 

стилизованному слою правой кнопкой и выберите Copy Layer  

Style/Копировать стиль слоя. Теперь кликните правой кнопкой по слою, 

который пока без стиля, и выберите Paste Layer Style/Вставить стиль слоя.  

  

  
При желании вы можете окрашивать определенные элементы. К примеру, 

мы хотим окрасить лавровые веточки. Для этого кликните дважды по слою, 

чтобы открыть его стили и во вкладке Color Overlay/Перекрытие цвета 

укажите режим наложения Multiply/Умножение и выберите цвет. В нашем 

случае это зеленый  # b9cda5.  
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Попробуйте этот же эффект на других видах бумаги, например на картоне. 

Вопросы для закрепления.  

1. Какие виды графических форматов Вы знаете?  

2. Какой объем графического файла допустим на web – странице?» 

3. Назовите способы оптимизации графических файлов 4.Что такое 

сценарий?  

  

Практическая подготовка № 13  Создание эффекта теснения на бумаге 

Методика и порядок выполнения работы  

Для выполнения задания воспользуемся предоставленным уроком. 

Задание  

Цель и содержание работы: ознакомить обучающихся с техникой 

эффекта теснения на бумаге и работой инструмента Текст в Photoshop.  

Для выполнения практической работы необходимо использовать 

приведенные ниже образцы.  

Задания для выполнения лабораторной работы  

Создайте по образцу эффект тиснения на бумаге   

В этом уроке мы будем создавать реалистичный эффект тиснения на 

бумаге в Adobe Photoshop. Вы можете применить эффект к вашему лого, или 

любому другому объекту, или же начать с создания эмблемы, с которой будете 

работать. Далее нам понадобится лишь один слой со стилями слоя. Обязательно 

попробуйте эффект на разных типах бумаги, а также вообще на иных текстурах 

типа камня, дерева или кожи.  
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Для начала нам нужна текстура бумаги, на которой мы будем делать наш 

эффект. Поместите ее в новый слой нового документа. Это белая текстура, мы 

сможем выкрасить ее в любой цвет.  

  
Создаем изображение  

Поместите в новом слое ваш логотип, текст или изображение, к которому 

хотите применить эффект. Вы можете использовать что угодно: текстовые слои, 

векторные изображения или даже обычные вырезанные растровые объекты. В 

нашем случае это текстовые слои, для которых использован шрифт Cambria и 

лавровые веточки.  
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Создаем эффект  

Кликните дважды по одному из слоев, к которому  хотите применить 

эффект. Откроется окно стиля слоя. В нем укажите параметры как на картинках 

ниже, применив стили Inner Shadow/Внутренняя тень, Inner Glow/Внутреннее 

свечение, Bevel and Emboss/Тиснение и Color Overlay/Перекрытие цвета.  

  
В итоге у вас должно получиться примерно следующее:  
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Чтобы указать эти же стили остальным слоям, кликните по уже 

стилизованному слою правой кнопкой и выберите Copy Layer 

Style/Копировать стиль слоя. Теперь кликните правой кнопкой по слою, 

который пока без стиля, и выберите Paste Layer Style/Вставить стиль слоя.  

  
При желании вы можете окрашивать определенные элементы. К примеру, 

мы хотим окрасить лавровые веточки. Для этого кликните дважды по слою, 

чтобы открыть его стили и во вкладке Color Overlay/Перекрытие цвета 

укажите режим наложения Multiply/Умножение и выберите цвет. В нашем 

случае это зеленый  # b9cda5.  

  
Попробуйте этот же эффект на других видах бумаги, например на картоне.  
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Практическая подготовка № 14  Создание в фотошопе логотипа с 

текстурным фоном  

     Цель и содержание работы: ознакомить обучающихся с техникой 

текстурирования фона под коженную текстуру.  

Теоретическое обоснование  

              Аппаратура и материалы для выполнения практической работы 

такие же, как и для выполнения практической работы № 1.  

Указания по технике безопасности полностью совпадают с 

изложенными в описании практической работы № 1.  

Методика и порядок выполнения работы  

Для выполнения практической работы необходимо использовать  

приведенные ниже образцы.  

    Задания для выполнения лабораторной работы  

              Создайте в фотошопе логотип с текстурным фоном из кожи и 

лентой  

  

  
Сегодня мы сделаем в фотошопе логотип с текстурной подложкой из кожи 

и поперечной лентой с текстом. Сначала создадим текстурный фон. Для этого 

немного трансформируем прямоугольник, потом сверху наложим текстуру кожи. 

После этого шаг за шагом создадим ленту. Сначала основную часть, применим к 

ней стиль слоя. Потом аналогичным образом создадим боковые части с 

вырезанными краями. Далее напишем текст, немного обработаем его для 

придания объема. После этого напишем вспомогательный текст на текстуре, 

сверху и снизу, и декорируем текст звездочками. А в заключении поместим 

готовый логотип на кожаную обложку.  

 Шаг  1.  

Создаем в фотошопе новый документ 20х20 см, заливаем его цветом #dad7c6.  

Шаг  2. Выбираем инструмент «Прямоугольник со скругленными краями» 

(Rounded Rectangle Tool), радиус скругления задайте 50 пикс., цвет #474634 и на 

новом слое создаем фигуру.  
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Шаг 3.  

Выбираем «Редактирование» (Edit) > «Трансформирование» (Transform) > 

«Деформация» (Warp) и деформируем фигуру, как показано на рисунке ниже.  

  
Шаг  4. После этого воспользуемся кожаной текстурой N1. Вставляем 

текстуру в наш документ поверх фигуры, созданной в предыдущем шаге, и 

меняем режим наложения на «Мягкий свет» (Soft Light).  

  
Шаг  5. После этого идем в «Изображение» (Image) > «Коррекция» 

(Adjustment) > «Цветовой тон/Насыщенность» (Hue/Saturation) и ставим галку в 

поле «Тонирование».  
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После этого обрезаем лишнюю текстуру вокруг фигуры. Щелкнуть по 

миниатюре слоя с фигурой, удерживая Ctrl > нажать Shift+Ctrl+I для 

инвертирования выделения > нажать Del.  

Шаг  6. После этого можно объединить слой с текстурой и фигурой. А к 

получившейся фигуре применить стиль слоя «Тень» (Drop Shadow) размером 50 

пикселей и прозрачностью 50%.  

  
Шаг  7. На этом шаге выделим фигуру, потом откроем контейнер «Окно» 

(Window) > «Контуры» (Paths) и в нем щелкнем по значку «Сделать из 

выделенной области рабочий контур» (Make Work Path From Selection). Далее 

выбираем инструмент «Текст» (Type Tool) и пишем пунктиром по контуру.  

  
 Шаг  8.  

Теперь применим к пунктирным стежкам стиль слоя «Теснение».  

http://www.designonstop.com/tutorials/beginners/kak-v-fotoshope-napisat-tekst-po-krugu-s-pomoshhyu-instrumenta-kontury.htm
http://www.designonstop.com/tutorials/beginners/kak-v-fotoshope-napisat-tekst-po-krugu-s-pomoshhyu-instrumenta-kontury.htm
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 Шаг  9.  

После этого снизим прозрачность слоя со стежками до 60%.  

  
 Шаг  10.  

На новом слое создаем прямоугольник, заливаем его цветом #d6c693.  

  
Шаг 11.  

  

Применяем к нему стиль слоя «Наложение узора» (Pattern Overlay). Узор марля. 

Не торопитесь давить «ОК» сначала примените все стили слоя необходимые для 

ленты.  
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 Шаг  12.  

Потом применяем стиль слоя «Тень» (Drop Shadow), цвет #706c53.  

  

  
 Шаг  13.  

Потом стиль слоя «Внутреннее свечение» (Inner Glow).  

  
 Шаг  14.  

Потом стиль слоя «Внешнее свечение» (Outer Glow).  
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Теперь можно нажать «ОК» И 

результат:  

  
 Шаг  15.  

Теперь делаем копию слоя с лентой и перемещаем ее под слой с текстурой, 

немного сдвигаем влево и вниз. С края вырезаем уголок для имитации края 

ленты. В стиле слоя отключаем внешнее и внутреннее свечение и немного 

меняем угол наклона тени.  

  
 Шаг  16.  

Делаем еще один дубликат слоя. Также перемещаем его под слой с текстурой, 

немного сдвигаем вправо и вниз. С края вырезаем уголок для имитации края 

ленты. В стиле слоя отключаем внешнее и внутреннее свечение и немного 

меняем угол наклона тени. Получили такой результат.  
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 Шаг  17.  

Теперь на новом слое инструментом «Прямолинейное лассо» (Poligonal Lasso 

Tool) выделяем теругольник, как на рисунке ниже. Заливаем его цветом #1b1a11. 

Делаем тоже самое с другой стороны и получаем объемную ленту.  

  
 Шаг  18.  

После этого печатаем текст Портфолио шрифтом Impact (N40), цвет #53503d.  

Применим к тексту стиль слоя «Тень» (Drop Shadow), размер 1 пиксель, цвет 

#e7be3f, «Осветление» (Screen), прозрачность 62%.  

  
 Шаг  19.  

После этого делаем дубликат слоя с текстом, отключаем стиль слоя, смещаем 

текст вниз и вправо на несколько пикселей. Снижаем прозрачность слоя до 35%.  
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Шаг 20.  

Не много украсим шрифт придав ему текстуру кожи под №2.  

Вставляем текстуру в наш документ поверх текста. После этого идем в 

«Изображение» (Image) > «Коррекция» (Adjustment) > «Цветовой 

тон/Насыщенность» (Hue/Saturation) и ставим галку в поле «Тонирование».  

   
После этого обрезаем лишнюю текстуру вокруг текста. Щелкните по 

миниатюре слоя с текстом, удерживая Ctrl > нажать Shift+Ctrl+I для 

инвертирования выделения > нажать Del. Результат:  

  
Шаг  21. После этого пишем небольшой текст сверху на самой текстуре. 

Шрифт Book Antiqua, размер 20 пикселей, цвет #d6c693. Прозрачность слоя 

снизим до 80%.  
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Шаг  22. Тем же самым шрифтом размер 15 пикселей пишем небольшой 

текст снизу.  

Прозрачность слоя снизим до 80%.  

  
Финал  

Ну и в заключении поместим наш логотип на обложку. Отключите видимость 

слоёв: Фон и Слой 1 и одновременно нажмите четыре клавиши ( 

Shift+Ctrl+Alt+E) таким образом вы продублировали слои и склеили их. 

Воспользуйтесь текстурой №3 и поместите её под логотип.  
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После этого идем в «Изображение» (Image) > «Коррекция» (Adjustment) > 

«Цветовой тон/Насыщенность» (Hue/Saturation) и ставим галку в поле  

«Тонирование» и выставляем настройки как на картинке.  

  

  
Обложка готова!  

  
  

  

Практическая подготовка № 15  Фото манипуляции в программе 

Photoshop  

Цель и содержание работы: ознакомить обучающихся с техникой 

коллажирования в Photoshop.  
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Теоретическое обоснование  

              Аппаратура и материалы для выполнения практической работы 

такие же, как и для выполнения практической работы № 1.  

Указания по технике безопасности полностью совпадают с 

изложенными в описании практической работы № 1.  

Методика и порядок выполнения работы  

Для выполнения практической работы необходимо использовать  

приведенные ниже образцы.  

    Задания для выполнения лабораторной работы  

              Создайте эффект имитации поверхности земли в Photoshop  

  

                                           Имитация поверхности земли  

Земля и камни являются очень важной частью сложных сцен. Они кажутся 

очень простыми, но в то же самое время, это довольно сложные объекты, чтобы 

визуализировать их достаточно правдоподобно. Текстура не появится сама по 

себе - для этого требуется правильная обработка. В данном большом уроке я 

покажу вам, какие из инструментов программы Фотошоп вы можете 

использовать, чтобы ваши изображения земли, камней, гор, пустыни и скалистых 

выступов выглядели максимально натуралистично.  

1. Создаем изображение обычного куска земли  

  
При рисовании простых сцен, земля является необходимым злом. Мы 

знаем, что все будут игнорировать ее и сосредоточат свое внимание на главном 

объекте\персонаже, но если мы пропустим ее, то это не останется незамеченным. 

Я покажу вам способ, как создать изображение простого куска земли, при этом с 

возможностью его настройки, который будет идеальным изображением для фона 

или же послужит в качестве основания для какого-то более детализированного 

объекта.  

Шаг 1  

Начните со сцены, которую вы хотели бы покрыть землей. Если объекты 

находятся на отдельном слое, расположите землю под ним, если нет, нарисуйте 
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основание вокруг него и используйте его в качестве обтравочной маски (Control-

Alt-G) для всех слоев. Залейте это основание базовым для вашей земли цветом.  

  
Шаг 2  

Создайте новый слой (Ctrl+Shift+N). Залейте его любым цветом. Далее 

переходим в Фильтр - Шум - Добавить шум (Filter > Noise > Add Noise).  

  
Шаг 3  

Теперь, применим инструмент Свободное трансформирование (Free 

Transform Tool (Control-T)), чтобы слегка расплющить текстуру.  
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Шаг 4  

Еще раз возьмите инструмент Свободное трансформирование. Кликните 

по угловым точкам с зажатой клавишей CTRL, чтобы появилась возможность 

тянуть их по отдельности. Таким образом, вы сможете настроить расположение 

вашей текстуры в соответствии с необходимой нам перспективой.  
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Шаг 5  

Далее делаем двойной клик по слою. Идем в раздел Смешивать если 

(Blend If). Здесь нам нужно немного поиграть со слайдерами во втором ряду, 

чтобы сделать темные области частично прозрачными. (Чтобы разделить 

ползунки слайдеров и двигать их по отдельности, необходимо удерживать 

клавишу Alt)  

  

  

  
Шаг 6 Теперь, переходим в режим быстрой маски (Quick Mask Mode (Q)).  

https://photoshop-master.ru/lessons/les4487/7.jpg
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Для того, чтобы выделить отдаленную область земли, воспользуйтесь Мягкой 

круглой кисточкой (Soft Round brush).  

  
Шаг 7  

Нажмите Q еще раз, чтобы выйти из режима быстрой маски, и 

инвертируйте выделение, нажав комбинацию клавиш (Control-ShiftI). Откройте 

Окно - Корректировка (Window > Adjustments) и выберите Яркость\Контраст 

(Brightness/Contrast). Уменьшите значение контраста до минимума, насколько 

это возможно, а яркость наоборот выкрутите на максимум. Это позволит создать 

вам эффект воздушности для перспективы.  

  

  
Шаг 8  

Найдите текстуру, которую вам бы хотелось использовать для земли. Она 

не должна быть излишне детализированной - лучше, если она будет более 

хаотичной. Для данного урока использована вот текстура Dirt texture.  

Воспользуйтесь  инструментом Свободное  трансформирование (Free  

Transform Tool), чтобы настроить ее перспективу, также как мы делали это с 

шумовой текстурой.  
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Если в вашей текстуре присутствуют элементы, которые не должны быть 

слишком растянуты, не доводите границу текстуры к самому горизонту - мы 

исправим это немного позже.  

  
Шаг 9  

Примените Маску слоя (Layer Mask) или просто воспользуйтесь 

инструментомЛастик (Eraser Tool), чтобы плавно смешать край текстуры.  

  

  
Шаг 10  

Сбросьте Насыщенность (Saturation) до минимума при помощи 

комбинации Control-U. Цвет нашей текстуры никоим образом не должен влиять 

на тот цвет, который мы выбрали для нашей земли.  
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Шаг 11  

Примените корректирующий слой Уровни (Levels) при помощи 

комбинации клавиш Control-L, чтобы поправить чрезмерный контраст между 

светлыми и темными элементами.  

  

  
Шаг 12  

Измените Режим наложения (Blend Mode) на Перекрытие (Overlay).  

  
Шаг 13  
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Скройте слой со столбами и фон с небом, остальные выделите и при 

помощи комбинации клавиш Ctrl+Shift+Alt+E объедините в один слой и затем 

понизьте при помощи комбинации Control-U насыщенность.  

  
  

Шаг 14  

Далее, перейдите в Режим быстрой маски (Quick Mask Mode (Q)). 

Выделите область, освещенную источником света.  

  
  

Превратите маску в выделение. Увеличьте немного значение Яркости  

(Brightness).   
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Шаг 15  

Добавьте корректировку по средствам Цветового баланса (Color Balance) 

и сдвиньте цвет освещаемой земли до цвета источника света, который ее 

освещает.  

  
Шаг 16  

Тени появились сами собой, но мы можем сделать на них еще больший 

акцент. Выделите их при помощи Быстрой маски  (Quick Mask).  

  
Затем  примените корректировку Яркость/контрастность 

(Brightness/Contrast), чтобы сделать тени более темными и менее 

контрастирующими (Слои - Новый корректирующий слой - 

Яркость/контрастность (layer - new adjustment layer  

- brightness/contrast)).  
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Шаг 16  

У подножья колонн уложите немного камней.  

  
И сделаем немного мягче переход между небом и землей. Активируйте 

быструю маску клавишей Q и мягкой кистью проведите прямую.  

  
Выйдите из быстрой маски и инвертируйте выделение  
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Войдите во вкладку Фильтр—Размытие по Гауссу и поставьте значение 

6. Теперь граница стала менее четкой.  

  
  

Все! Задача выполнена!  

  

Практическая подготовка № 16  Создание эффекта калейдоскопа в 

Photoshop  

     Цель и содержание работы: ознакомить обучающихся с техникой 

коллажирования в Photoshop.  

Методика и порядок выполнения работы  

Для выполнения практической работы необходимо использовать  

приведенные ниже образцы.  

    Задания для выполнения лабораторной работы  

              Создайте эффект калейдоскопа в Photoshop  

Основная задача в данном уроке – это найти способ легко воссоздать 

эффект калейдоскопа, но при этом сделать это не вручную, просто разместив 

огромное число копий изображения, а используя некий алгоритм.  

К счастью, в программе Фотошоп есть пара полезных особенностей, 

которые значительно упростят выполнение данной задачи.  

https://photoshop-master.ru/lessons/les4487/23.jpg
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Во-первых, часто упускают из вида такую опцию, как скриптовая (по 

сценарию) заливка, которая делает работу по созданию узоров калейдоскопа 

достаточно быстрой и имеет достаточное количество настроек, чтобы занять вас 

экспериментированием с ними на несколько часов! Также сопряженная с ней 

такая функция как Применить снова (Transform Again/Shift+Ctrl+T), позволяет 

нам интересным способом создавать повторяющиеся объекты.  

Данный метод похож на работу Спирографа.  

1. Создаем узор  

Заливка по сценарию особенно полезна при создании именно этого вида 

эффекта, но она требует для работы заранее подготовленный узор. Мы начнем 

нашу работу с того, что отделим бабочку (это изображение и станет нашим 

узором) от фона и создадим из него узор, который и будем использовать в нашем 

проекте.  

Шаг 1  

Данный метод будет работать практически с любым изображением, но 

конкретно для этого проекта давайте поработаем именно с изображением 

бабочки.  

  
Шаг 2  

Выберите инструмент Быстрое выделение (Quick Selection Tool (W)) и 

пройдитесь по изображению бабочки, чтобы полностью выделить ее. Если 

случайно будет захвачена нежелательная часть фона, то можно зажать клавишу 

Alt, и пройтись по этим участкам, чтобы снять с них выделение.  
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Шаг 3  

Используйте созданное выделение в качестве маски слоя: Слои - 

Слоймаска - Показать выделенную область (Layer > Layer Mask > Reveal  

Selection).  

  
  

  
Шаг 4  

Кликните по миниатюре слоя, чтобы быть уверенным, что вы работаете 

именно со слоем, а не его маской. Затем, выполните команду Редактирование - 

Определить узор (Edit > Define Pattern). Назовите этот узор "Бабочка".  
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2. Выполняем заливку на основе сценария  

Теперь, имея в активе готовый узор, пришло время использовать метод 

сценарной заливки, чтобы создать калейдоскопный узор. Есть несколько 

вариантов, с которыми можно поэкспериментировать. Те варианты, которые 

перечислены здесь, только лишь для примера, чтобы вы могли начать. В 

дальнейшем, вы можете поэкспериментировать и создавать свои собственные 

эффекты с помощью узоров.  

Шаг 1  

Создайте новый документ Файл - Создать (File > New). Назовите 

документ «Калейдоскоп»,установите Ширину (Width) и Высоту (Height) 30х30 

см. Установите Содержимое фона (Background Contents) Другое (Other) и 

задайте цвет черный (#000000).  

  
Шаг 2  

Создайте новый слой с помощью комбинации клавиш Shift-Control-N и 

дайте ему название Сценарная заливка (Scripted Fill).  

  
Шаг 3  

Далее выполняем команду Редактирование - Выполнить заливку (Edit > 

Fill) / Сочетание клавиш Shift+F5. В разделе Содержание (Contents) выбираем 

опцию Регулярный (Pattern). И в меню Заказной узор (Custom Pattern) 

выбираем наш заготовленный узор "Бабочка". Ставим галочку в чекбоксе 
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Сценарий (Script) и в активированном окошке выбираем опцию Заливка с 

Симметрией (Symmetry Fill).  

  
В диалоговом окне Заливка с Симметрией (Symmetry Fill) выставьте 

следующие настройки:  

 •  Тип симметрии (Symmetry type): 32Симметрия обоев Р6 (32  

wallpaperP6 symmetry)  

• Масштаб узора (Pattern Scale):0.93  

• Перемещение узора по ширине (Pattern translation along 

width):  

25% от ширины (of width)  

• Перемещение узора по высоте (Pattern translation along 

height): 41% от высоты (of height)  

 •  Произвольность цвета (Color randomness): 0  

 •  Произвольность яркости (Brightness randomness):0  

  

  

  
Шаг 4 Теперь добавим корректирующий слой: Слои - Новый 

корректирующий слой - Цветовой тон/Насыщенность (Layer - New  

Adjustment Layer - Hue/Saturation).  

 •  Цветовой тон (Hue): 0  

• Насыщенность (Saturation): -57  

• Яркость (Lightness): -62  
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Шаг 5  

Далее, возьмите инструмент Эллипс  (Ellipse Tool (U)), переведите его в 

режим рисования Контура (Path) и нарисуйте окружность в центре документа. 

Чтобы нарисовать именно окружность, удерживайте при отрисовке клавишу 

Shift.  

  

  
Шаг 6  

Добавьте новый слой (Shift-Control-N) и назовите его " круг" (Guitar 

Circle). Затем вновь выполните команду Редактирование - Выполнить заливку 

(Edit > Fill) / Сочетание клавиш Shift+F5. В этот раз в окне рядом с чекбоксом 

Сценарий (Script) выбираем опцию Разместить вдоль контура (Place Along 

Path). В появившемся диалоговом окне выставляем следующие настройки:  

• Масштаб узора (Pattern Scale): 0.71  

• Интервалы (Spacing): -230 пикселей  

 •  Ставим галочку в Настроить интервалы по размеру (Adjust  

spacing to fit)  

 •  Расстояние от контура (Distance from path): 295 пикселей  

 •  Прогрессия масштабирования (Scale progression): 100%  

• Произвольность цвета (Color randomness): 0  

• Произвольность яркости (Brightness randomness):0  



  111  

  
На данном этапе у нас должно получиться примерно следующее:  

  

  
3. Займемся трансформацией  

Чтобы создать эффект "цветка" мы воспользуемся интересной опцией 

Фотошопа, которая называется Трансформировать опять (Transform Again). 

Есть ощущение, что данная опция программы есть счастливое стечение 

обстоятельств, нежели разработанная функция. Так или иначе, она есть в 

программе, и она очень полезна для быстрого создания узоров на основе 

математических моделей.  

Шаг 1  

Создайте копию слоя «круг» (Ctrl+J)  

Выполните команду Редактирование - Трансформирование (Edit > 

Transform (Control-T)). В верхней панели настройки инструментов установите 

значения для ширины (width) и высоты (height) по 90% и угол поворота 

(rotation) на 25 градусов. Нажмите Ввод (Enter) чтобы применить 

трансформацию.   
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Делаем копию получившегося круга. Снова выполните команду 

Редактирование - Трансформирование (Edit > Transform (Control-T)). В 

верхней панели настройки инструментов установите значения для ширины 

(width) и высоты (height) по 90% и угол поворота (rotation) на 20 градусов. 

Нажмите Ввод (Enter) чтобы применить трансформацию.   

Создавая копию получившегося круга, выполняйте команду 

трансформироание и каждый раз меняйте только угол поворота на 5%. С 25% до 

10%.  

Должен получиться результат:  

  
Шаг 2  

Теперь к последнему получившемуся кругу примените комбинацию 

клавиш(Ctrl+J)+ (Ctrl+Shift+T).  Проделайте эти команды5-6 раз.  
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Шаг 3  

Добавьте корректирующий слой: Слои - Новый корректирующий слой - 

Цветовой тон/Насыщенность (Layer - New Adjustment Layer -  

Hue/Saturation).  

 •  Цветовой тон (Hue): 0  

•  Насыщенность (Saturation): -30 • 

 Яркость (Lightness): -13  

  
Шаг 4  

Добавьте еще один корректирующий слой Цветовой тон/Насыщенность 

(Hue/Saturation), но разместите его над второй копией слоя " круг". Переведите 

данный корректирующий слой в режим обтравочной маски, чтобы он 

воздействовал только лишь на эту копию, а не на все нижележащие слои. 

Команда: Слои - Создать обтравочную маску (Layer - Create Clipping Mask), 

или же просто нажмите сочетание клавиш Alt-Control-G. Настройки для этого 

корректирующего слоя следующие:  

 •  Цветовой тон (Hue): 0  

• Насыщенность (Saturation): -22  

• Яркость (Lightness): +7  

Шаг 5  

Создайте новый слой поверх всех слоев и назовите его Градиент 

(Gradient). Удостоверьтесь, что основной цвет (foreground color) у вас черный, и 

активируйте инструмент Градиент (Gradient Tool (G)). Используйте градиент От 

Основного цвета к Прозрачному (Foreground to Transparent), форма градиента 

радиальный (Radial). Нарисуйте градиент с исходной точкой в центре вашего 

документа.  
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4. Завершаем наш проект  

В заключительной стадии нашего проекта будут использованы те же самые 

методы, что и раньше, но теперь это будет работа с более простыми линиями и 

формами.  

Шаг 1  

Возьмите инструмент Многоугольник (Polygon Tool (U)), установите 

Стороны (Sides):5, Заливка (Fill): нет цвета (null), Цвет Обводки (Stroke Color): 

белый (white), и толщина обводки (stroke): 4 пикселя, затем нарисуйте 5-

сторонний многоугольник в центре вашего документа.  

  
Шаг 2  

Теперь идем в Слои - Растрировать - Фигуру (Layer - Rasterize - Shape), 

чтобы превратить векторное изображение в растровое. Затем зажимаем клавишу 

Alt и кликаем по глазу напротив миниатюры данного слоя. Это позволит сделать 

видимым только этот слоя, остальные будут отключены. Затем, выполните 

команду Редактирование - Определить узор (Edit > Define Pattern) и назовите 

его Многоугольник (Polygon).  
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Шаг 3  

Снова кликаем с зажатой клавишей Alt по глазу напротив миниатюры 

данного слоя - это вернет видимость всех остальных слоев. Добавьте новый слой 

над корректирующим слоем Hue/Saturation 1 и назовите его Background Lines.  

  
Шаг 4  

Воспользуйтесь командой Редактирование - Выполнить заливку (Edit > 

Fill), выберите в качестве заказного узора (Custom Pattern), наш только что 

определенный во 2-ом шаге узор Многоугольник (Polygon). В качестве сценария 

(Script) выберите Заливку с симметрией (Symmetry Fill).  
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В диалоговом окне Заливка с Симметрией (Symmetry Fill) выставьте 

следующие настройки:  

• Тип симметрии (Symmetry type): 33 Симметрия обоев Р6м (33 

wallpaperP6M symmetry)  

• Масштаб узора (Pattern Scale): 0.4  

• Перемещение узора по ширине (Pattern translation along width): 50% 

от ширины (of width)  

• Перемещение узора по высоте (Pattern translation along height): 50% 

от высоты (of height)  

• Произвольность цвета (Color randomness): 0  

• Произвольность яркости (Brightness randomness):0  

  
Спрячте слой с многоугольником.  

Работа готова!  
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Практическая подготовка № 17  Ретушь фотографий  

Для выполнения практической работы необходимо использовать  

приведенные ниже образцы.  

Задания для выполнения лабораторной работы 

Сделайте ретушь на предоставленных фотографиях Шаг 

1.  

Откройте фотографию, которой требуется ретушь. Создайте дубликат. 

Внимательно посмотрите на фото, очень много проводов. Все их убирать не 

будем, а только лишние - провода, которые идут поперек и толстые провода. 

Сделайте света, тоновую и цвета коррекцию.  

До коррекции  
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После коррекции  

  
  

После ретуши  

  
Шаг 2. Теперь можно приступить к ретуши. Выберите любой из 

инструментов для ретуши. В данном случае подойдет инструмент Заплатка.   

  
Шаг 3.  
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Для того что бы лучше видеть мелкие детали, нужно увеличить картинку. 

Так вы более качественно сделаете свою работу.  Начните убирать мелкие и 

тонкие детали, освобождая место для того, что бы клонировать чистую область 

под более крупные детали.  

  
Шаг 4.  

После того, как убраны крупные детали, в труднодоступных местах надо 

зачистить инструментом Штамп.  

  

Практическая подготовка № 18  Создание эффекта отражения в воде  

Цель и содержание работы: ознакомить обучающихся с техникой 

коллажирования и спецэффектов в Photoshop.  

Теоретическое обоснование  

              Аппаратура и материалы для выполнения практической работы 

такие же, как и для выполнения практической работы № 1.  

Указания по технике безопасности полностью совпадают с 

изложенными в описании практической работы № 1.  
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Методика и порядок выполнения работы  

Для  выполнения  практической  работы  необходимо 

 использовать приведенные ниже образцы.  

    Задания для выполнения лабораторной работы  

              Создайте эффект отражения в воде в Photoshop  

  

  
Шаг 1.  
Создайте новый документ: ширина 15 см, высота 21 см, 300пикс/дюйм.  
Шаг 2.  
Откройте фотографию старинного здания и уберите лишние. Убирать будем инструментом 

«Рамка» с настройками как на скрине.  

 
Выделите здание, частично захватив небо и деревья.  
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Шаг 3.  
Теперь надо убрать элементы, которые портят вид:  

 
Примерно так:  
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Шаг 4.  
С помощью инструмента «Пластика» опустите немного левую и правую стороны.  

 
Шаг 5.  
Теперь поместите наш обьект в документ, который создали ранеесделайте дубль и 

активируйте инструмент «Трансформация», щелкните мышкой в центре и выбирите «отразить 

по горизонтали». Сдвиньте картинку в низ.  

  
Шаг 6. Что бы сделать воду. Надо создать текстуру. Создайте новый документ и назовите его 

вода:  
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Примените фильтр «Шум» с настройками:  

  
Примените фильтр «размытие по Гауссу» со значением Радиус 5 пикс.  

  
Перейдите к коррекции «Кривые» и выставите значения, как на скриншоте.  
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Примените фильтр Эскиз—Рельеф ссо следующими настройками:  

  
Следующий фильтр Размытие – Размытие в движении с настройками:  

  
Шаг 7.  
Выделите весь холст инструментом «Прямоугольная область» с растушевкой 0 пикс, 

скопируйте текстуру в буфер обмена (Ctrl + C) и вставьте его в основной документ 

(Ctrl + V).  
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Шаг 8.  
Активируйте инструмент «Трансформация»  (Ctrl + T), кликните правой кнопкой 

мыши на холсте и выберите режим Перспектива. Растяните нижние углы в стороны, 

как показано на скриншоте.  

  
Назовите слой «Текстура» Шаг 

9.  
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Кликните правой кнопкой мыши на слое «Текстура» и выберите пункт Дубликат слоя.  

  
В верхней части холста будет прозрачная область (пустой участок). Чтобы избавиться 

от него, перейдите в меню Изображение-- Тримминг. Выберите пункт Прозрачные 

пмксели и нажмите ОК. Сохраните новый документ с текстурой (Ctrl + S) как 

отдельный PSD файл.  

  

Шаг 10.  

Закройте документ с текстурой и вернитесь к основному. Скройте слой «Текстура».  

Кликните правой кнопкой мыши на слое «Слой 1 копия» и выберите пункт 

Преобразовать в смарт- объект.  

К слою « Слой 1 копия » примените фильтр --Галерея фильтров—Стекло.  
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Кликните на иконке, отмеченной на скриншоте, и выберите пункт Загрузить 

текстуру. Выберите созданную текстуру.  

Чем больше Вы поставите значение параметра, тем сильнее будут волны. Мы 

работаем со смарт-объектом, а это значит, что Вы в любой момент сможете 

изменить настройки фильтров.  

  

Шаг 11.  

Включите слой «Текстура» и установите его режим наложения на Мягкий свет, 

понизьте непрозрачность до 18%.  

Обычно вода имеет тот же оттенок, что и небо. Выберите инструмент Кисть (B), 

зажмите клавишу Alt и определите цвет неба. Создайте новый слой «Цвет» и залейте 

его голубым цветом (Alt + Backspace).  

Опустите слой «Цвет» под слой «Текстура.  
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Установите цвета по умолчанию (D) и поменяйте их местами (X). К слою «Цвет» 

добавьте маску и выберите инструмент Градиент (G), настройте его так:  

  

Понизьте непрозрачность слоя «Цвет» до 30%.  

В завершении урока мы улучшим цвета фотографии. Поверх всех слоёв создайте 

корректирующий слой Кривые и настройте каждый канал отдельно:  
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Создайте корректирующий слой Яркость-Контрастность, чтобы усилить 

контрастность. Установите режим наложения на Умножение и понизьте 

непрозрачность до 56%  
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Изображение выглядит слишком симметрично, можно его не много обрезать 

Используйте инструмент Рамка (C).  
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